
I NEED HELP!

WELCOME to on-line help! Daphne here, your Dogz Adoption Guide.    This help system is
designed to give you the facts and a few hints about Dogz.    Dogz are very independent 
creatures, they know how to amuse themselves, so they won't get frustrated if you don't 
know how to throw them the ball right away.

For more information and other fun stuff,    check out the Dogz Web site at
www.pfmagic.com/dogz/adopt
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ABOUT DOGZ
YOUR DOGZ

Dogz are the first pets to live on a computer, giving you the joys of owning a dog without the need for a pooper 
scooper! Dogz live on your desktop where they can scamper across applications, play games like keep away, fetch 
and chase, or nap in the corner of your screen while you're working.

Dogz love to play.
Play fetch, keep away, and tug-o-war.

Teach your old Dogz new tricks.
Your Dogz can learn to beg, roll over, or even do back-flips.

All Dogz are Different.
Adopted as puppies, your Dogz will develop a unique look and personality.

Dogz love to interact with their owners.
Pet your Dogz.    Pick them up and carry them around your desktop.

Dogz protect their home and your computer.
Your Dogz will bark if an unwanted intruder enters your desktop.
Dogz also protects your computer screen against "burn-in" while you're away from your desk.

Choose from 5 Dogz Breeds.
There's Scrappies, Jowls, Chips, Bootz,    and Chichis.

Groom your Dogz.
Choose your favorite colors for your desktop pal.

Dogz are flexible.
You can control your Dogz.
You can play with it over the full screen, or keep it in its "Playpen."



INSTALLING DOGZ

SYSTEM REQUIREMENTS

Windows 3.1 and Windows '95 Compatible
486DX, 50 MHz recommended; at least 486DX, 25MHz required
Windows 3.1 Enhanced Mode required;    Win '95 compatible
VGA color display required; 256 colors highly recommended
Mouse required
6 MB of free Hard Disk space required
4 MB of available RAM required
Optional: Windows-compatible sound card and speakers for sound effects



ADOPTING DOGZ
FIND A FRIEND

Adopting your Dogz will give you a great excuse for taking breaks at work.

To start, double-click your Dogz icon.    If you are using Windows 95, select Dogz from the START menu.

If you have never run Dogz before, you will enter the Adoption Kit.      Here you will be given a chance to pet and 
play BALL with five different breeds of puppy Dogz for as long as you need to find the perfect desktop companion.  
If you decide later that you would like to adopt a different Dogz breed, you can always return to the Adoption Kit by
selecting Activate Adoption Kit from the Options menu.

Once you have chosen your Dogz and are ready to adopt, just click the ADOPT ME NOW button on your screen and
I, Daphne your friendly Adoption Guide, will tell you what to do.



LAUNCHING

INTRODUCING YOUR DOGZ TO YOUR DESKTOP

Once you have adopted your Dogz all you need to do is launch Dogz.    This is a big step but don't worry, Dogz are 
well-adjusted creatures.    It will be no time before your Dogz is romping around its new environment like it owns the
place.

To launch,    double-click on your Dogz icon.

If Dogz is already running, but in the background, and you want to bring it to the top of your desktop just use ALT-
TAB to select it, or click on any visible Dogz window.

If you want your Dogz to be "Always on Top" while you're running DOGZ WITH OTHER APPLICATIONS click 
the control box (the little button on the upper left corner of the Dogz PLAYPEN window) and select "Always on 
Top."    With most, but not all applications, this will let you keep your Dogz Playpen window visible at all times.



PETTING
A GOOD PAT GOES A LONG WAY

Not every Dogz likes the same thing, some sneeze at the thought of being petted on the nose, and some love it.    
You'll need to get to know your Dogz' soft spots.

You must be empty-handed to pet your Dogz.    Click the left mouse button while the petting hand cursor is 
anywhere over your Dogz.    Hold the left mouse button down and gently stroke your Dogz.

You can pet your Dogz inside the Playpen or when it is in Full Screen mode.

DAPHNE'S Petting HINT 



GRABBING
JUST PICK THAT PUPPY DOGZ UP

When your Dogz is being naughty, picking it up and placing it where you want it to be is a good way to let your 
Dogz know who is in charge.    It won't hurt your Dogz and it will help your relationship.

To grab your Dogz, click the right mouse button while the cursor is anywhere over it.    Hold the right mouse button 
down and carry your Dogz wherever you want to place it.

Release the right mouse button and your Dogz will safely drop to the desktop.    



CALLING YOUR DOGZ
"COME HERE!"

If only everyone acted like a Dogz, running over to you at the snap of your fingers.

To get your Dogz to come to a specific location at any time, just double-click the left mouse button over that 
location.    This will "snap your fingers." Remember you can't "snap your fingers" when you are carrying a toy.    You
must have a free hand to call your Dogz over.    

Dogz won't just go taking off all over your desktop at any old time.    A Dogz waits to be told that it can run around 
the Full Screen.

Also, if your Dogz is in its Playpen it won't come over to a location outside of the Playpen.    Dogz have a keen sense
of manners and wait to be let out of their Playpen before romping all over your desktop.

For more information *See PLAYPEN / FULL SCREEN.



DOGZ Toolbox

GETTING THE GOODIES

All a Dogz needs in life are a few cool toys and stuff, and we give them all to you free when you adopt.    Clicking 
the left mouse button on any of the toys in the Toolbox will allow you to use them to interact with your pet.

Click on the toy and drag it to the desktop.    If your Dogz is in the Playpen, toys cannot be dragged outside the 
Playpen area.

For more information See* 
CAMERA
SPRAY BOTTLE
PAINT BRUSH
SHOE
DOGZ DISHES
BALL
TREATS

PUTTING TOYS AWAY
To put all toys away at once, choose "Clean up Toys" from the options menu. 
To put away a specific toy, either:

Click once on the grayed-out toy icon in the toolbox, or
Drag and drop the toy back into the toy area of the toolbox.



PLAYPEN / FULL SCREEN

PUTTING YOUR DOGZ OUT / LETTING 'EM IN
Your Dogz can be confined to its Playpen.    This is like fencing in your Dogz because it can no longer run around 
the other applications on your Desktop.    Putting your Dogz in its Playpen is a good way to have it keep you 
company while you work.

Just click the large FULL SCREEN icon on the DOGZ Toolbox to let your Dogz out of its PLAYPEN.    It will 
safely scamper across applications you have running and play with you.    If your Dogz is running around and you 
want to put it away, click the Playpen FULL SCREEN icon again to keep it safe in the Playpen.

If you want a quick shortcut to put your Dogz away, just press the ESC key on your keyboard.    Also, switching to 
other applications (using ALT-TAB) or opening dialog boxes will automatically pop your Dogz back into the 
Playpen.

To keep an eye on your Dogz in its Playpen while you work, you may want to set up the Playpen window to be 
Always on Top.

DAPHNE'S Boss in the Room HINT 



SPRAY BOTTLE

BAD DOGZ!

The key to training your Dogz is squirting it with the SPRAY BOTTLE when it does something bad, and giving it a 
treat when it does something good.    But you can reward a Dogz for hogging the ball if that's what you want to teach
it to do.

When your Dogz is being naughty and you want to teach it to behave, squirt it with the SPRAY BOTTLE.
 
To select the SPRAY BOTTLE just click and hold your left mouse button on the SPRAY BOTTLE icon in the Dogz 
Toolbox and drag it to the desktop.    

Bring the SPRAY BOTTLE close to your Dogz and spray it after it does something bad, by releasing the mouse 
button.    This will teach your Dogz that this behavior is not acceptable and with repeated effort it will teach it not to 
do it in the future.

You don't need to use the Spray Bottle too often to teach your Dogz a lesson.    As soon as you squirt the bottle, it 
will automatically return to the Toolbox.



PAINT BRUSH

COLORING YOUR DOGZ...    THIS SEASON'S TOP DOGZ LOOK

Dogz aren't vain creatures.    They tend to shy away from fashion.    But a cool-colored Dogz is the mark of a proud 
owner.

To color your Dogz, first select the color set you want to use by choosing "Brush Color" under the "Options" menu.  
Then select the PAINTBRUSH tool, drag it over your Dogz and position the tip of the brush on the color area you 
want to change.    Release the mouse button to paint the area selected.    The brush will automatically return to the 
toolbox.

To learn how to restore your Dogz original color *See RESTORE ORIGINAL COLORS 



CAMERA
LOOK AT THE MUG ON THAT MUTT

Dogz crave attention of all sorts.    Taking a snap shot of your Dogz shows that you are proud of it.    

Click on the CAMERA icon to take a snap shot of your Dogz.    An image will appear on your screen with the option
to "save or cancel."    If you decide you want to save your snap shot ("Mutt Mugz")    a numbered .BMP file will be 
created and stored in the /DOGZ/MUGZ directory of your hard drive.    

Each time you save a Mutt Mugz, a new image will be created (e.g.    "DOGZ01.BMP, DOGZ02.BMP).    You can 
create up to 99 Dogz Mugz.    If you fill up the Mugz directory, you might want to delete or move your old photos to 
another directory and start over.

You should be able to open, edit, and print your Mutt Mugz with any Windows paint program.

You can send your Mutt Mugz into the Dogz Web Site at www.pfmagic.com/dogz/adopt, to be displayed somewhere
on the site.    If you have joined the Kennel Club (which, as a Dogz owner, you can do for free), send your Dogz' 
Mutt Mugz to be displayed on the web site!    If you have your own web page or email address we can display these 
as well so you can meet other Dogz owners!

DAPHNE's Mutt Mugz HINT
 



TREATS
THROWING THE DOG A BONE (OR A BISCUIT)

Like many things in life, bribing your Dogz with treats is the best way to get it to do what you want it to.

The three TREATS: the biscuit, the byte, and the bone appear on the bottom of the Toolbox.    They can be used to 
train your Dogz to do lots of different tricks or simply to reward it for good behavior.    

To reward your Dogz, grab a TREAT and drop it on the desktop whenever it does something good (e.g.    brings the 
BALL back quickly, or rolls over).

 To learn how to teach your Dogz tricks, *See    TRAINING 



DOGZ DISHES

SINGING FOR YOUR SUPPER

A Dogz has gotta eat and drink sometime.    When your Dogz gets hungry or thirsty, it'll beg to be fed.    It may take 
awhile for you to figure out what it's begging for, but eventually you will get to know the small differences unique to 
your pet.    This is the sign of a good owner.    

When your Dogz wants food or water, click on the DOGZ DISH or WATER DISH icon with the left mouse button 
and drag it to the desktop.      When you release the mouse button, the DISH will be dropped onto the desktop and 
your Dogz will start to eat and /or drink.    You can get your Dogz to "sing for its supper" by holding the dish above 
its head to get it to beg.

When the DOGZ DISH or WATER DISH is empty, you need to put it back in the Toolbox and get a fresh bowl to 
refill it.

There are three ways to return the DISH to the Toolbox.    

Click once on the grayed-out icon for the dish in the Toolbox.
Click on the DISH that is on the desktop with the left mouse button.    Drag it into the DOGZ Toolbox and 

release the mouse button.    
Select the "Clean Up Toys" menu item from the Options menu.    This will return the DISH and all other 

toys to the Toolbox.

Dogz don't die if you don't feed them, they just get really hungry and thirsty.    And overfeeding a Dogz is not    good 
for your Dogz' health.

DAPHNE'S Well Fed HINT 



BALL

YOU GOTTA HAVE BALLZ

Dogz can sense when something fun is about to happen.    Your Dogz will get excited when it's playing fetch.    It will 
try every different trick it knows just to get you to throw the BALL.    

Use the BALL to play Fetch with your Dogz.    Click on the BALL icon in the Toolbox with your left mouse button 
and drag it to the desktop.    To play with it just click on the BALL and drag it to the desktop.

Your Dogz will start doing tricks to get you to throw the BALL.

To throw the BALL, move the mouse rapidly while holding down the mouse button, then release.    The BALL will 
fly in the direction you "throw" it.

Your Dogz will chase the BALL and grab it (unless it's more interested in something else).    If your Dogz is being 
naughty, it may not return it right away (or it'll guard the BALL when it brings it back).    You can give your Dogz a 
quick spray with the SPRAY BOTTLE to let it know it's misbehaving.    You can also try to get your Dogz to come 
over to you by "snapping your fingers" -- double clicking the left mouse button.    This will communicate that you 
want it to hurry up and (if it's listening) it will run over to you.

If it is good and returns the ball quickly, give your Dogz a TREAT .

To put the BALL away just click CLEAN UP TOYS in the Options menu,    click on the grayed-out BALL icon in 
the Toolbox, or (if your Dogz is out of the Playpen in Fullscreen mode) drag & drop it back into the Toolbox.



SHOE

A TOY EVEN YOUR PET WILL LOVE
Even the most loyal of Dogz needs a little challenge.    Tug-of-War is a game of resistance and your Dogz' only 
chance to compete with you.    Be sensitive... especially if your Dogz is a wimp.

To select the SHOE, just click and hold your left mouse button on the SHOE icon in the Toolbox and drag it to the 
desktop.

Wave it in front of your Dogz to tease it.    Your Dogz will see this as a challenge and most likely attack the SHOE.    
Now you are playing Tug-of-War.

Try and get your Dogz to grab hold of the SHOE and swing from it as you move it around.

When you want to stop playing Tug-of-War click on another icon in the Toolbox or select CLEAN UP TOYS from 
the File Menu.

To put the SHOE away just click CLEAN UP TOYS in the Options menu,    click on the grayed-out ball icon in the 
Toolbox, or drag & drop it back in the Toolbox.



TRAINING
TRICKS FOR TREATS

Performing tricks for treats is your Dogz' way of learning how to please you.    But Dogz are not Einsteins, they need
practice, and might forget what you've taught them after awhile.    

How it works: Dogz remember the tricks that get them TREATS.    If your Dogz gets a TREAT right after doing a 
trick, it will make a mental note and will try that same trick in the future.

Each TREAT can be used to train your Dogz to do a different trick (e.g.    the byte can be used for a "rollover" trick 
or the biscuit for a back flip).    First, click on one of the TREATS and drag it to the desktop.    

Your Dogz will naturally try different tricks, to get you to drop the TREAT.    If it keeps doing tricks you don't want, 
try waving the TREAT by holding the left mouse button down and wave the TREAT back and forth rapidly.    (This 
is like saying "not that one" or "try again").

As soon as you see the trick you want your Dogz to learn, release the left mouse button to drop the TREAT.    Your 
Dogz will know it was successful and eat the TREAT.    Remember:    repetition is key!

To learn how to change the trick your Dogz does for a certain TREAT,    *See LEARNING 

DAPHNE'S Tricky HINT 



LEARNING
YOU CAN TEACH AN OLD DOGZ NEW TRICKS

It will take several tries, but your Dogz can be trained to do "new" tricks to replace the ones it has already learned.    
Just repeat the training process, but wait for the trick you want.    Wave the TREAT a lot to encourage it to try 
different tricks (instead of the one it had learned).    When you see the new trick, drop the TREAT and it will 
understand this is what you want it to do for this particular TREAT.    But remember, a Dogz needs practice through 
repetition to learn new things.

For more information *See TRAINING 



TRICKS
BEGGING WILL GET YOU EVERYWHERE

Your Dogz does tricks not just for treats, but for food and playing fetch as well.    If your Dogz decides it would like 
to play fetch, it will start to do the "I want to play fetch" tricks.    You'll learn to recognize these over time.    A Dogz 
learns which tricks work when you reward it.    If, for example, your Dogz does a rollover and you immediately put 
down the BONE, it'll learn that that trick works for getting a BONE to munch.

For the How To's of Tricks *See TRAINING 



GUARD DOGZ

HOLDING DOWN THE HOMEFRONT

Dogz are loyal to your privacy.    Not only will they stay in their Playpen when you tell them to, they will also guard 
your Desktop while you are away.

When you stop using your computer for a pre-defined period time, which you can set in GUARD DOGZ OPTIONS 
(e.g.    10 minutes), your Dogz will appear on screen and begin marching around, watching for trouble.    If anyone 
touches the keyboard or moves the mouse, one of two things will happen...

If a password has NOT been set...
The lights will come back on in your computer and your Dogz will greet you,    happy that you've returned.

 If a password HAS been set...
The Dogz will begin barking, letting everyone know someone is trying to snoop through your desktop.    Until the 
correct password is entered and the OK button is pressed, the Dogz will continue barking to let everyone know 
someone has been tampering with your computer!

To set this up choose Guard Dogz Options from the Options menu.

You can turn the sound off for Guard Dogz so that your Dogz won't annoy neighbors while you're away.

Don't forget your password.    Write it down somewhere safe.
If you do lose your password, you can restore the original Dogz system settings.

Re-start your computer, then edit the CONTROL.INI file located in the Windows directory.
Delete the following lines, and then run Dogz.

[ScreenSaver.Guard Dog]
PWProtected=1

[ScreenSaver]
Password=xxxx



CREATE AN ADOPTION KIT

LENDING A HELPING HAND

Creating an Adoption Kit is a great service you can provide for the many Dogz that need cool homes, and for the 
friends you know that need desktop companions.    Giving an Adoption Kit to a friend lets them play with all five 
breeds and decide which puppy is the perfect match for them.    They can adopt their own Dogz from a software 
retailer.

The files will be copied to the disk selected.    Then just give out disks to everyone you know who needs a computer 
companion.

ACTIVATE ADOPTION KIT

Selecting "Activate Adoption Kit" will return you to the Dogz Adoption Kit and allow you to select a new 
puppyDogz for adoption.    The Dogz you have been playing with will disappear from your computer and return to 
the Dogz Adoption Agency.



GENERAL OPTIONS

WHAT ELSE CAN I DO?

By selection General Options from the Options Menu you can change the following:

SOUND 

DOGZ NAME
"HERE .......WHAT'S YOUR NAME?!?"
Your Dogz name appears in the title bar of its Playpen window.

ON-SCREEN INDICATOR
WHERE IS MY DOGZ?
Turn the "Dogz" Corner Logo or border on or off by clicking the check box next to these options.    These are visible 
reminders when Dogz is in Full Screen mode.

OTHER OPTIONS

PLAYPEN BACKGROUND
DECORATING THE PEN
This lets you select the artwork that appears in the background of your Dogz Playpen.    This artwork is pulled from 
the "/PLAYPENZ" directory inside the DOGZ directory. Files that begin with "256," are designed for systems with 
at least a 256 color display.    Any .BMP files stored in that directory are available for use.    If you have favorite tiles 
you want to use, drop them into that directory.    

Pressing the left or right arrow buttons will flip through the options.    The options won't appear until you click OK 
and leave the General Options window.

AUTOSAVE CAMERA
This will automatically save your photos after every great shot.



GUARD DOGZ OPTIONS
ON GUARD (Guard Dogz actually works as a screen saver with Password protection)
Choose this to tell your Dogz to guard your computer when you're away.    If you choose "Off", it won't guard the 
screen and the other options on this window will be disabled.

GUARD DOGZ DELAY
The number of minutes your Dogz waits before coming out to guard your screen.

GUARD DOGZ
WHEN THE MOON HITS YOUR EYE
While your Dogz is guarding the screen, the moon will appear.    Choose the way you want the moon to appear by 
selecting from the Moon pop-up list.

GUARD DOGZ SOUND EFFECTS
Turn the check box off here to make sure no sounds are heard when your Dogz is guarding the screen.    

Note that if you have turned Sound Effects off in the "General Options" window, this check box has no effect 
(because sounds are all off).

PASSWORD REQUIRED
Check this box and click the "Set" button if you want to create a unique password to protect your computer.    When 
the "Select Password" window appears, enter the password you would like to use.

CHANGE YOUR PASSWORD 
As you type, asterisks (*) will appear instead of the letters or numbers, to prevent anyone from learning your 
password by looking over your shoulder.    

But everybody gets paranoid, sometimes.    So, to change your password, just type in your old password in the Enter 
Old Password box, then press Tab and type your new password in the Enter New Password and Confirm New 
Password boxes.    



SOUND EFFECTS

NEED AN EFFECTIVE METHOD TO QUIET THAT POOCH?
When your Dogz is barking up a storm just shut their sound off.    Dogz do not have big egos; they will 
understand...of course they will keep howling all the same but it won't reach your ears.

Selecting the "Sound Effects" turns sounds on and off.    If turned off, you will not hear your Dogz at any time in 
Playpen, Full Screen, or even in Guard Dogz mode.    Note that you can turn sound off for Guard Dogz separately 
under the "Guard Dogz Options" menu.



CLEAN UP TOYS

MESSY DOG

This is what you always wanted -- an instant cleaning device! 

Just select "Clean up Toys" to immediately move any toys (e.g.    ball, food bowl, etc.) that are out on the Desktop 
(or in the Playpen) back into the Dogz Toolbox.



RESTORE ORIGINAL COLORS

FASHION SENSE

To return your Dogz to the color it was when you adopted it, select Restore Original Colors under the Options 
Menu.



EXIT

"GET OUT!"

EXIT Quits the application and sends the Dogz away until you run Dogz again.
Select Exit from the Options Menu or close the Dogz Toolbox (or the Playpen) by clicking on the "close corner" of 
the Toolbox (or the Playpen) and then select Close.



AGING

GROWING UP IS HARD TO DO

Your Dogz will get a little older every day.    When it's a puppy Dogz, it'll be a little more rambunctious, clumsy, and 
impressionable.    Fortunately, these Dogz never really get old or die.    They get to be mature and stay that way 
forever! And old Dogz can keep LEARNING new tricks!



MOODS

WELL, AREN'T WE MOODY!

Like you, your Dogz has different moods.    So if it doesn't want to play, it's just in a bad mood, and there is not 
much you can do about it...    except maybe give it some treats, or try to make it feel better by petting it.



SLEEPING

TAKING A SNOOZE

Dogz know when to sneak in a good nap.    If you are not playing with it after awhile, it will just lay down and sleep. 
You can wake it up gently by petting it.

Dogz also sleep at night, so you rarely need to worry about your Dogz being grumpy in the morning.



BREEDS

PICK YOUR PET
Scrappies
These Dogz will do anything to convince you to pet them.    And believe me, they know how to give you those eyes.

Chichis
These Dogz love to play fetch.    I swear, their favorite thing in the world is chasing that ball! Getting them to give it 
back is another story....

Jowls
Bulldogz are ferocious Guard Dogz but deep down they're really tender-hearted.

Chips
These Dogz are quick learners, which means you can bribe them to do just about anything.

Bootz
Setters grow to be big and strong so you might want to feed them a lot.    And they play a mean game of Tug-of-War.



DOGZ WITH OTHER APPLICATIONS

WORKING WITH YOUR PET
Using Dogz with Other Applications:

If you want to be able to keep an eye on your Dogz while using other applications, do the following:

Make sure your Dogz is in its Playpen (remember: if it is outside of the Playpen, and in Full-
Screen mode all other applications are inactive--even if you can see them).

Open the other application(s) you would like to use (e.g.    a word processing program).
Open the document you want to work on.    Make it as small as comfortable, leaving room 
for the Dogz Playpen to one side of the document.

Click on the Dogz Playpen to make it active.    If it is hidden behind other windows, use ALT-
TAB to select Dogz.    This will bring it on top .

Resize the Playpen until it fits in the space available.    Move the Dogz Toolbox out of the way.

Click again on your other application window and begin work.    Your Dogz should be visible in
its Playpen.    Your Dogz will occasionally wander off, but it tries to stay where you can see it.    

You can set ALWAYS ON TOP for Playpen window to make sure the Playpen window floats on top of most other 
windows.    To do this, click the control box (it's the little button at the top left corner of every Windows application) 
of the Dogz Playpen window and select Always on Top.    A check mark should appear.    To turn it off, select it 
again.



KENNEL CLUB MEMBERSHIP
JOIN THE KENNEL CLUB

The Kennel Club is the exclusive meeting place for Dogz owners around the world.    Once you've adopted your 
Dogz, membership to the Kennel Club is free.    All you need to do is register your Dogz at the Dogz web site:    
www.pfmagic.com/dogz/adopt.    Here you can get the latest info on Dogz, such as club contests and events, as well 
as meet other Dogz owners.



TROUBLESHOOTING

GENERAL

Be sure to read the README.TXT file that is installed with Dogz for other    important troubleshooting items.

If you're having trouble with sounds, colors, getting the Dogz' attention, or any other matter, try closing Dogz and 
re-opening.    This should clear up most problems.

Problem: While Dogz is running, I can't use any other applications.

Solution: While Dogz is in Full Screen mode (i.e.    the Dogz is running freely around the screen and Dogz 

logo is in the corner), you cannot use your other applications.    You need to put the Dogz back in its Playpen before 

you can do anything else.

THERE ARE 4 WAYS TO BRING UP OTHER APPLICATIONS WHILE DOGZ IS IN FULL SCREEN 
MODE:

Press the ESCAPE key while in Full Screen mode.    The Dogz will return to its Playpen.    This is like 
saying "Go inside."

Press ALT-TAB (the standard Windows method) to switch to other applications quickly.    Your Dogz will 
return to the Playpen automatically.

Click the "Full Screen/ Playpen" icon to put your Dogz back into its playpen.

Quit Dogz by closing the Dogz Toolbox window (click the close box or choose EXIT from the Options 
menu).

COLOR
Dogz requires at least a 16 color VGA monitor. Dogz look even better if 256 colors are available.

COLOR FLASH
Dogz runs in 16, 256, or more colors.    You may see a color "flash" when launching Dogz.    This is normal.

If you have exactly 256 colors and you have a colorful image on the screen and launch Dogz, the colors in the image
may appear to change. This "palette shift" is temporary and will not effect the image itself.    Quitting Dogz will 
return color to normal.

NO SOUNDS ARE HEARD
Make sure the "Sounds On" option is set in the "General Options" window.
Dogz do not make sounds when other applications are in the foreground.    Try clicking on the Dogz 

window to bring it to the foreground.    Sounds should be audible
Dogz will not make sounds when the Playpen is minimized (this is a quick way to quiet your Dogz down!). 

Make sure the Playpen is open on the screen or that you are in Fullscreen mode.
Make sure you have a SoundBlaster-compatible card installed in your computer and that it is connected to 

external speakers.    Dogz will not produce sounds without a SoundBlaster-compatible card.

NOTE TO SYSTEM ADMINISTRATORS
Dogz is a system-friendly application.    It makes no changes to the AUTOEXEC.BAT or CONFIG.SYS files on a 
user's computer.

During installation, a copy of WING.DLL is placed in the Windows/System directory.





DAPHNE'S Tricky HINT
Repetition is the key.    Repeating the same process several times helps your Dogz to learn what to do.    To see the 
same trick again, pull out the same TREAT and wave it until you see the trick you want it to learn.    Dogz aren't 
perfect so don't get discouraged.    It takes a little while to train Dogz.



DAPHNE'S Well Fed HINT
If your Dogz doesn't eat, don't worry - an uninterested Dogz is just a full Dogz.



DAPHNE'S Petting HINT
Dogz have been known to become entranced by their owners' petting from time to time.    Most cases involve a 
prolonged period of time rubbing the Dogz stomach.    They even fall into a deep sleep.    If this happens while you 
are petting your Dogz, it is a good indication that you have an exceptional relationship.    



DAPHNE'S Boss in the Room HINT
If your boss walks in the room while your Dogz is in FULL SCREEN mode, quickly press the ESCAPE key on your
keyboard.    This will let your Dogz know what is happening and it will immediately go to its PLAYPEN and look 
innocent.



DAPHNE'S Mutt Mugz HINT
If you are having trouble catching split second photo opportunities of your Dogz, try pressing the space bar on your 
keyboard.      It has the same effect as clicking the CAMERA icon, but it can be faster.    .    .    almost as fast as your 
Dogz!

 




